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Welcome

SiteMap is the fast and easy way to create a great-looking site map page in your 
RapidWeaver website. With a site map, users can easily find what they are looking for 
and jump directly to that page – itʼs essentially just like having an "index" page in a book 
with links. 

A site map is a page in your RapidWeaver created website that visitors can view to 
quickly find pages or the specific information they want. This page can be displayed as 
Tree View, Alphabetical View, or Categories. Visitors to your website see the page titles 
or browser titles (depending on how you set up SiteMap) and even blog post titles in the 
list of pages available in your website.

You can choose to hide specific pages from the site map or even from the search 
engines. You have total control over what is seen and what is not. 

SiteMap can also create a sitemap.xml document for search engines like Google, 
Yahoo, and Bing to use to quickly catalog your site. SiteMap can "ping" Google, Yahoo 
and Bing to notify them of updates to your site when you make updates and publish 
those changes. 

The SiteMap plugin allows RapidWeaver to publish this sitemap.xml file to your server 
when you publish your website. SiteMap can even tell RapidWeaver to publish the 
sitemap.xml file to the root (index directory) of your website, which is the recommended 
placement. The creation of the sitemap.xml file also happens when you export your 
website to a local folder.

Quite simply, SiteMap gives you control over what is visible to visitors and what is visible 
to the search engines.

To get the best use of your new SiteMap Plugin, please read this manual and keep a 
copy for future reference. SiteMap is easy to use, and knowing the purpose of each of 
the parts will help you get the best results as well as the look you want. 
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Terms & Definitions

SiteMap - the name of the plugin that is a page style for RapidWeaver

site map - a page in your website that provides a map of all pages in the site (or all 
pages you have chosen to add to the map)

sitemap.xml - the name of the file that is uploaded when you publish a website with this 
selection checked (this is the file that is used by search engines to help catalog your 
website and also to know the priority of pages and the frequency of changes to those 
pages)

OPML - an XML outline format used by applications like OmniGraffle Outliner
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Basics

Finding Your Downloaded Plugin

Safari and Firefox generally default to the Downloads folder found in your username 
under Places in the Favorites Panel of the Finder Window. 

If you are not sure where this folder is, go back to the browser you used to download 
the plugin and view the Downloads Panel. In Safari, it is found in the Window menu (or 
option+command+L). In Firefox, look in the Tools menu (or command+j).

Installation

1. Double-click on the sitemap.rwplugin icon 
2. Quit RapidWeaver
3. Open RapidWeaver 

Uninstalling

1. In the Finder, open the folder Home > Library > Application Support > RapidWeaver
2. Find the sitemap.rwplugin and move it to the trash 

Hint: If you are running 10.4.0 (or later) Tiger, you can use Spotlight to search for 
sitemap.rwplugin.

Requirements

Mac OS X 10.4 (or later) 
RapidWeaver 3.6 (or later)
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Registration

After your payment is complete, you will see the page with the Registration Code. You 
should also receive an email with this information. Often this email is sent in just a few 
minutes, but depending on payment type, can also take up to 6 hours. The confirmation 
email will contain your registration code. Keep this email in a safe place. If you reinstall 
RapidWeaver, you may need it again. 

Copy the registration code from your email software.

The registration code will be a few lines down the page. It will something look like this: 

Serial Number: BxXtMox123pw53Mx5t302Ay12Ty8ZGii5pug==

Select your code and choose Copy from the Edit menu (command+c).

Open Rapidweaver and open a new Rapidweaver document by choosing New Project 
from the File menu. 

Create a new SiteMap page. Click the + button to add a new page, choose SiteMap 
from the list, and click the Add button. 

Enter the Rapidweaver Page Inspector (shift-cmd-i or View->Page Inspector) and click 
on the page settings. The page settings button is on the far right-hand side with a little 
toolbar icon. 

Click on the Registration tab. The Registration tab is where your registration code will 
be entered. 
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Paste in your registration code. Choose Paste from the Edit menu. You can also type 
your registration code in by hand if you need to but, we strongly recommend you 
copy & paste to simplify the process and reduce the possibility of errors. Make 
sure to enter the code exactly as it is in the email. If all goes well, a confirmation should 
appear right below the registration code that reads, "Thanks for buying SiteMap!"  
 

I lost my Serial number.  How do I retrieve it? 

To retrieve lost license codes, you need to go to two spots and fill out forms.  There are 
two spots because there are two different ways to get licenses that have different 
retrieval methods – just do both and you should be good to go! 

http://store.esellerate.net/support 
https://store.loghound.com/store/lost_license 

You will need the email you used to register the program.  All of your eSellerate and 
Loghound purchase serial numbers will be resent to you. 
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Setting Up SiteMap

First Steps
Now that you have installed the SiteMap Plugin, you can use it on any new or existing 
website you have created in RapidWeaver.

To add a SiteMap page to an existing website:
1. Open that site project in RapidWeaver. 
2. Select the page in the sidebar that will be just before the new site map page while 

you are in edit mode. 
3. Select Add from the top bar of RapidWeaver to add a new page style. Select SiteMap 

from the list and then click on the Choose button at the bottom of the panel or simply 
press your Return key on your keyboard.

4. Use the Preview and Edit buttons at the top of the RapidWeaver Project Panel to 
toggle between viewing the site map as it will look in a web browser and the edit 
mode where you can do your setup. Setup is covered in the following pages in this 
manual.

To add a SiteMap page style to a new project:
1. Select New Project (command+n on the keyboard) to start a new website project.
2. Select Save (command+s) and save your new project to a file folder on your Mac. It is 

recommended to save to a folder in your Documents Folder on your Mac.
3. Add a homepage to your website by using the Add button at the top of the 

RapidWeaver Project Panel and then click on the Choose button at the bottom of this 
panel. Select a page type appropriate for being a Home Page. Suggested page types 
are: styled text, blog, stacks or other content-driven page types.

4. Now use the Add button to add a new page to the site and select the SiteMap page 
type and then click on the Choose button at the bottom of this panel.

5. Save your site by using the command+s buttons on the keyboard.

NOTE: You can move any page in the left sidebar into a new position in the page 
hierarchy by clicking down on the page you want to move and drag it up or down in the 
list.

Now you are ready to start configuring your site map as you wish to use it. Play around 
with the options and have fun. See the different ways you can set up the site map.
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Site Map Tab
Let's get started in edit mode in RapidWeaver, in the first panel and the first tab in that 
panel named Site Map.

Content Header Text 
The large area just below the three top tabs is the header text area. This gives you 
space to write some content and information for the viewer to read about your site map. 
This shows at the top of the webpage content area above the site map.

This area is great for adding a title to the page content area, giving the viewer 
information related to the site map, and adding images for some color, links to other 
important or related information, and more. 

Setting up this header text is optional and is at your discretion. It's also OK to leave it 
blank!

Use it like you would any styled text area in RapidWeaver. Place text, images, and even 
code in this panel. Use the RapidWeaver Format Menu to style the text or ignore the 
formatting for code. 

There are two buttons at the bottom of the page while in edit view for adding and 
removing links to text or images in the content header area.

Display Modes
Your site map can have different looks depending on which output mode you choose. 
Think of this page, if active in your site, as having an index or table of contents that 
helps the viewer see the available pages on your site.

Tree View
Choosing the default Tree View gives you a linked map that is a list of pages in your site 
in the order the site is set up from top to bottom.
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Alphabetical
This display shows the links to your pages in your site, 
divided into sections for each letter of the alphabet. Links 
that start with A will show just below the A section. Links 
that start with M will show just below the letter M in the M 
section. This setting is set to be A-Z by default.

You can customize this area to suit your language and your 
alphabet. This is done in the Page Inspector (command
+shift+i). Select the Page Tab then the sub-tab named 
Alphabet. This is covered in more detail later in this 
manual.
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By Category
If you have set up categories (covered 
later in the manual) you can display 
the links to the pages in your site 
listed by category. This allows viewers 
to find information related to an area 
of interest.

 (Note:  To use category view, you 
have to assign pages to categories.  If 
you donʼt assign categories nothing 
will show up!).

You can always come back and 
change to this or any other view at any 
time and republish your site with the 
new look 
 

Column View
You can choose from 1 to 
6 columns. SiteMap will 
try to split your list of 
pages into the number of 
columns you have 
selected as evenly as 
possible. SiteMap will 
also try to not break up a 
Category or Alphabetical 
grouping.

Use this to make a large site map easier to use and not as long on the page.
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Show Description
If you add Description Meta Tag 
to your page, SiteMap can 
display that in the site map to 
help the user know more about 
that specific page.

Description Meta Tags are added 
in one of two ways. The next 
section of the manual shows how 
to add this Meta Tag in the Site 
Organization Tab as you set up 
information about each page of 
your site. 

You can also use the 
RapidWeaver Page Inspector 
(command+shift+i) in the upper 
panel of the Header tab to add 
your Meta Tags. The Description Meta Tag will show in the site map if selected. See the 
next section of this manual for further details (while this works fine itʼs generally 
recommended to use the ʻSite Organizationʼ tab). 

Site Organization Tab

This tab is where you get to organize and communicate about your site. Here you have 
the opportunity to add a description and/or category(s), change folder and file names, 
hide the page in the site map, and even notify you if a default RapidWeaver folder or 
filename has not been changed.
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What does the 'Show Defaults that need changing' button do? 

It only shows web pages where you haven't changed the default title, filename, or folder 
name. Selecting this will display the page or pages that still have the default folder and 
page name(s) created by RapidWeaver.

Example: page1/page1.html

Folder name= page1 and filename= page1.html

You can change these two names right in SiteMap by double clicking on the field for that 
item then typing in the new name. 

Alternatively you can use the RapidWeaver Page Inspector (command+shift+i) to 
change the folder and filename.

What does the "Don't allow publish if page defaults are still present" button do? 

SiteMap will stop the publish process if a page in the website still has the default title, 
filename, or folder name. Either change the default names to ones that are more 
descriptive or let RapidWeaver publish the files as they are by unchecking this box.

By default RapidWeaver creates folder and file names using numbers as you add pages 
to your site. 

Example: folder1/file1.html then folder2/file2.html

It is considered a best practice to change these to more meaningful names. 

Example: a contact form page could be changed to contact/index.html or contact/contact.html

This helps you to make sure you don't publish any ugly folder and file names.

How do I change the default title, filename, or folder name? 

Easy ... type new ones in the table, or go to the site inspector for that page! They both 
work (although I find the table to be faster). 
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What is the 'Description' column and how do I enter a Description? 

The Description is used to annotate the site map and it's also inserted in the meta data 
for that page to help search engines. 

To enter a description, double click on the Description Field and  type it in.

What is a category? How do I use it? How do I enter it? 

One of the site map views you can create is by category. 

Let's say you have pages on fish, ducks, and ponds. You may tag some things with 
category 'fish' and 'ponds' while others are 'ducks' and 'ponds'.  Each category will show 
the pages based on the tags associated with it. To enter them, just type them in for each 
page into the Category Field at the bottom of the Site Organization area with the page 
selected in the upper part of the panel that you want to add to or edit. Add them one at a 
time, hitting return between each one if the page belongs to more than one Category.

A Category Meta Tag will also be added to the Head of that webpage.

To adjust the spacing and font size of the category titles on the site map page, use the 
CSS in the Custom CSS Panel of the Page Inspector:

#sitemap  dt {
margin-top: 1em;
font-size: 1.4em;
}

Adjust the 1em or 1.4em to your liking. 

More CSS for styling appear later in this manual.

Hide in SiteMap
Checking this box for a specific page (or pages) will stop them from being displayed in 
the site map page on your website. You can change this status at any time and 
republish the website to update it.
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When you use the Don't Show in Menu function in the RapidWeaver Page Inspector 
for any page it also hides the page in the site map. 
Hiding the page in the site map does not hide it in the website navbar/menu if you have 
the Hide pages marked 'Don't show in Menu' in SiteMap checked in the Page 
Inspector > Page Tab > Output Tab. This is also covered later in this manual.

Search Engine Tab

You can do four things here: disable search, show the frequency the page is changed, 
prioritize the relative importance of each page in your site, and tell SiteMap to create a 
sitemap.xml file and place it on you server in the root of the site.

Disable Search
This removes the page from sitemap.xml AND it puts a 'ROBOTS=NONE' in your 
metadata to prevent search engines from crawling that page.

You can change this at any time and republish your website to update it.

Change Frequency
This tells the search engines how often the page changes. The theory is that if you give 
search engines honest hints, they can do a better job. I recommend you don't artificially 
state a page changes more often than it does. If a page is only updated once a year and 
you say it's updated monthly or even weekly, a search engine like Google may penalize 
you. 

Priority
These sliders set relative priority within your website. That tells Google and other search 
engines what priority you think the pages should be. Note that this is priority within your 
own pages, not against someone else on the web, and the priority is all relative. 
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If you use this feature, try to be balanced (e.g. make some low and some high) 
otherwise it won't do anything. The way I use it is I make my main entry pages high 
priority so Google should tend to prefer those.

Pushed all the way to right is highest priority. Pushed all the way to the left (all the way) 
will turn off priority for that site. If you want a low priority push it just a nubbin to the right 
(e.g. mostly, but not all the way to the left)

Create a "sitemap.xml"
This check box tells SiteMap to create and publish a sitemap.xml file to the root of your 
website. The root is the same location as your index.html, index.htm or index.php 
document, often known as the homepage.

Also see the Page Inspector > Page Tab > SiteMap Tab for additional checkboxes for 
this to work. This is covered below in this manual as part of the Page Inspector 
information.

What is sitemap.xml and who cares? 
The sitemap.xml is a file that search engines use to better index your site. It gives you 
the chance to specify relative importance of pages in your site as well as give hints to 
search engines on how often they change, etc. There is no guarantee that the search 
engine will actually listen to your hints but in general it seems to help provide more 
accurate searches. 

As of April 2007, Google and Yahoo will read the sitemap.xml file. The relatively new 
Bing will also read this file.

For everything you ever wanted to know about sitemaps, go to http://www.sitemaps.org 

Why do I get "Unsupported File Format" when I submit my site map to google? 
It's a little confusing since the word "sitemap" is used in so many contexts. 

First there is the plugin called Sitemap (this is what you install into RapidWeaver). 

This plugin generates two files. An HTML file and an XML file. The XML file is called 
sitemap.xml while the HTML file is whatever page name you give it (often index.html) 

It's the XML file that you want to submit to google. 
How do I submit my sitemap.xml to the search engines 
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Each search engine has its own particular way.  You can follow the instructions at the 
following links: 

Google: http://www.google.com/webmasters 
Yahoo: https://siteexplorer.search.yahoo.com/submit 

However, a more generic way to catch all engines is to include it in the robots.txt file. 
The 3 top search engines (Google, Yahoo, and Bing) will 'auto-discover' the sitemap.xml 
file (http://blog.ask.com/2007/04/sitemaps_autodi.html). 

Simply put the following text anywhere in your robots.txt file: 

Sitemap: [url to your sitemap]
For instance, at Loghound.com the robots.txt looks like this 

Sitemap: http://www.loghound.com/sitemap.xml

You can verify this by looking at it here http://www.loghound.com/robots.txt 

For more information, read this http://www.sitemaps.org/protocol.php#informing 

(Thanks to our resident SEO expert, Mark Notz, for his help in keeping up with site map 
events!) 

How do I tell Google or Yahoo to reindex me? 

For Google, you can do so here: http://www.google.com/webmasters 

For Yahoo, you can do so here: https://siteexplorer.search.yahoo.com 

NOTE:  starting with version 1.34U you can have sitemap automatically 'ping' Google, 
Yahoo, and Bing by entering the full address to the sitemap.xml into the 'sitemap' field. 

I changed my page to sitemap.xml but it wonʼt publish it! 

Sitemap produces a number of files. There is the default 'user viewable' page which is 
an html file (click here for an example). It can also (optionally) produce a 'sitemap.xml' 
file. This file is uploaded with any graphics, etc. that you have added to the 'files' 
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directory under the sitemap page (note that the 'files' directory is not always called 'files' 
but will always have the word 'files' in its name) 

One important tip – what you don't want to do is change the name of your site map page 
to sitemap.xml.  To create the sitemap.xml file for Google to index, just select "Create 
'sitemap.xml'.
My sitemap is not indenting properly! 

Most themes define the page CSS in a way that provides pleasant looking site maps but 
occasionally one resets the lists. To get you started, here is a snippet of CSS that 
should get your first level indentation looking right. Place this in the Custom CSS Panel 
of the Page Inspector. It's just a starting point so you will likely need to adjust it for your 
individual preferences. 

#sitemap ul { 
padding-left:40px; 
} 

Page Inspector

Page Tab

This contains the rest of the settings and the registration panel for SiteMap.

The first tab is the Registration. This has already been covered in the first part of this 
manual. 
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Output Tab

There are 5 functions you can set in this area to refine how your site map works:

1. Hide pages marked 'Don't show in Menu' in SiteMap checkbox makes sure pages 
that you have marked in the Page Inspector > General Tab to not Show in the Menu 
(navigation bar or navbar) to also not show in the site map. 

With this unchecked, you can allow the page to show in the site map even if it is not 
showing in the Menu/Navbar of the site.

2. Set ROBOTS Metadata to 'NONE' on 'Disable Search' checkbox will place a 
ROBOTS=NONE in the Meta Tags in the head of the web page document to tell the 
search engines not to catalog this page. This works for all "well-behaved" search but is 
not a guarantee that all Search Engine Spiders will leave the page alone.

3. SiteMap pages share settings. This checkbox if useful if you have more than one 
site map in a website. If you have two or more pages, selecting this means the site map 
pages share settings (which pages to hide/index, etc.) Most users probably want this 
off.

4. HTML Sitemap uses absolute references is useful and lets SiteMap create 
'absolute' references in the HTML page (this has no effect on the xml page for Google). 
Normally sitemap creates links to pages relative to itself (e.g. ../page1/page1.html) but 
selecting this option has SiteMap create links that are fully qualified (e.g. http://yoursite/
page1/page.html) Normally you'll want to keep this off as it makes the page less 
portable but in some situations (such as if you import a page into another page) this can 
be handy. Most users probably want this off.

5.This final option (drop down menu) is how SiteMap will display information related to 
the Page Title, Description, and Browser Title.  If you want the Browser Title you have 
set in the Page Inspector for your pages to be used, select the second option to display 
the Browser Title. If no Browser Title can be found, SiteMap will default to the Page 
Title. 
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OPML

This is an XML format that is used to store data in an outline format. Saving to an 
OPML format creates a file you can use to document the website. 

Click Save Website as OPML, select a folder to place the file in, and save. 

This file can be opened in software like OmniOutliner. OmniOutliner can read the OPML 
file and you can save the file in this application then open it in OmniGraffle for a 
graphical representation of your site.

OmniOutliner:
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OminGraffle

For more information on these applications, go to:  http://www.omnigroup.com/products/

Categories Tab

The Categories tab allows you to see the order of the site map either alphabetically or in 
a custom order. When the "Sort Alphabetically" checkbox is unchecked you can sort the 
names manually by clicking down on an item and dragging into a new position in the 
group. If you don't see anything in this area then you haven't set any categories for the 
pages. 
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Alphabet Tab
This tab gives you the option to display a legend at the top of your site map page. This 

is only available when you have selected the Alphabetical View in the SiteMap Tab that 
is above the main edit panel in RapidWeaver. 

The default for the site map legend is a regular English alphabet with each letter as a 
separate link.

You can use the panel on the right side of this Inspector area to define your alphabet. 
You have the option to group certain letters together (like using A-C in the first field 
instead of just A). This shortens the length of the legend and lists all the A through C 
pages and posts (if posts are included in the site map) under that one link as A-C.

You also have the option to exclude certain words from being linked in the Legend. It 
might be useful to exclude words like a, and, and or.
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Settings using AC, DF, etc…

Settings using A-C, D-F. Etc.
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Settings using numbers and letters:

Alphabetical only :
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Blog Tab

To display the blog post titles in the site map, check the box in this area. Next, set the 
number of posts to include in the site map. 

You can also choose to display blog post archives but only in Tree View or Alphabetical 
View. There is a predesigned format written into the field for this option. 

 Blog Archive Format  
This sets how the archived blog posts will be displayed

Example:
Archive: %b %Y - this shows the archived posts as a month name and 4 digit year (e.g. 
December 2009).

What to use to format:

%a = day as word
%d = day as number
%b = month name
%m = month
%Y = 4 digit year
 %y = 2 digit year

You can find these codes at any time by hovering your cursor over the Archive field.

SiteMap also allows you into include the blog posts specified in the sitemap.xml file that 
is created when you publish or export the website. This will allow the search engines, 
like Google, Bing, Yahoo, and Ask, to catalog those blog posts. 
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Sitemap Tab

The best place to publish the sitemap.xml file is to the root of your website. SiteMap can 
do this for you if you check the checkbox to tell SiteMap to do this when you publish 
your website. If you are someone who exports your website locally to your Mac and 
then upload the site using an FTP (File Transfer Protocol) application, SiteMap will 
place the sitemap.xml file in the proper location for you in the export folder.

You can have SiteMap ping (notify) Google, Yahoo, and Bing that your site has been 
changed and should be re-indexed. If you check this option, make sure to place the 
URL for the location of the sitemap.xml file in the field provided. 

Example: http://www.my_domain.com/sitemap.xml

This is where the sitemap.xml will be if it is in the root of your website.

Styling With CSS

As with most RapidWeaver page types, you can style the site map if you know the 
correct Selectors. If you are familiar with CSS, you can adjust the properties and values.

All CSS is placed in the Custom CSS Panel of the Page Inspector for the SiteMap page
(s). 

Remove Bullets From List
A quick way to remove the bullet points from the site map is to place this in the Custom 
CSS Panel:

#sitemap ul li {
list-style:none;
} 

This tells the browser to not show the bullets or the Unordered List (list-style: none;).
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A More Compact Site Map
This set of CSS will progressively set the next lower level of a nested list to show a 
small font size. The lower three will also show this inline (same line rather than one 
above each other) if the width is sufficient to do so.

#sitemap ul li { 
font-size:100%; 
} 
#sitemap ul li ul li{ 
font-size:90%; 
} 
#sitemap ul li ul li ul li{ 
font-size:80%; 
list-style:none;
display:inline;
} 
#sitemap ul li ul li ul li ul li{ 
font-size:70%; 
list-style:none;
display:inline 
} 
#sitemap ul li ul li ul li ul li ul li{ 
font-size:60%; 
list-style:none;
display:inline;
} 

An Overview of CSS For SiteMap
The late Peter Dominic Ryan wrote up a nice entry over at the Real Mac forums for how 
to use CSS with sitemap: 

I think the best way to approach CSS and your SiteMap is the way it is done in the RW 
Toolbar. The toolbar is just made up of nested unordered lists <ul><li><ul>...</ul>, and 
these are wrapped with a unique <div>. If you study the style sheet you will see the 
declarations are pretty much like the following: 
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Code: 
#navcontainer ul {…} 
#navcontainer ul li {…} 
#navcontainer ul li a {…} 
#navcontainer ul ul {…} 
#navcontainer ul ul li {…} 
#navcontainer ul ul li a {…} 
#navcontainer ul ul ul {…} 
#navcontainer ul ul ul li {…} 
#navcontainer ul ul ul li a {…} 

… 

Simply take the same approach with SiteMap, but this time it is wrapped with the 
following: 

Code: 

<div id="sitemap"> … </div> 

So, for each tag you want to style differently, you just make it a descendant selector of 
this <div>. As an example only, if your sitemap has three levels in its hierarchy, the 
following selectors (with declarations omitted for brevity) would do a nice starting job: 

Code: 
#sitemap ul { … } 
#sitemap ul li { … } 
#sitemap ul li a { … } 
#sitemap ul ul { … } 
#sitemap ul ul li { … } 
#sitemap ul ul li a { … } 
#sitemap ul ul ul { … } 
#sitemap ul ul ul li { … } 

#sitemap ul ul ul li a { … } 
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As I said above, take the toolbar as an example of how to approach this, and before you 
get stuck into the CSS, take a good look at the output markup of your SiteMap page for 
clues on how to best approach it.

Wrapping Up

Don't be afraid to try different setups and view the results on your site map page. You 
don't have to worry about the sitemap.xml file as it is a taken care of for you in the 
proper format and published to the correct location when you select to have SiteMap 
publish it for you. 

Remember, you can make changes and republish at any time. 

Make sure you create a robots.txt file to place in the root of your website that tells the 
search engines where to find your sitemap.xml file. Then give the Search Engines time 
to catalog you – it can take time to build and get your rating up.  

NOTE:  simply having a site map is no guarantee of top ranking. Ranking is also based 
on the titles and content of your site as well as how much competition you have for you 
subject area.

Credits

Writing:
Larry Pollock
http://www.insiderapidweaver.com
Manuals, books and education for RapidWeaver.

Editor:
Lauren Anderson
Copywriter & Editor
http://www.laurenanderson.ca
(519) 496-0845

Links
http://loghound.com/sitemap/ -- Loghound Sitemap
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http://www.sitemaps.org/  -- Sitemap.xml reference
https://www.google.com/webmasters/tools -- Where to manage your sites in Google
http://www.bing.com/webmaster -- Where  to manage your site in Bing.
https://siteexplorer.search.yahoo.com/ -- Where to manage your sites in Yahoo.

About John "Loghound" McLaughlin

John has been developing software for the Mac for over 5 years -- Previous to that he 
worked on windows and Linux software but chooses to ignore that painful part of his life.

John lives in beautiful Sonoma County, California with his wife and very active two boys.  
His main interest is in tools that make it easier for people to connect their digital life 
online.  
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